
Copying

See the information here to copy documents or photos using your product.

Note: Copies may not be exactly the same size as your originals.

Copying Documents or Photos

You can copy color or black-and-white documents or photos onto various sizes and types of paper,

including Epson special papers.

1. Place your original document or photo on the scanner glass.

2. Load the paper you want to print on in the product.

3. Press the home button, if necessary.

4. Press the left or right arrow button to select Copy and press the OK button.

You see this screen:

5. To print more than one copy, press the up or down arrow button to select the number (up to 99).

6. Press the left or right arrow button to select one of the following:

• Color: for color copies

• B&W: for black-and-white copies
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7. Press the OK button to view the print settings for the copies.

You see this screen:

8. Press the down arrow button to view the individual settings.

You see this screen:
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9. To change the print settings, press the left or right arrow button and select the necessary

settings. When you are finished, press the OK button.

10. When you are ready to copy, press the start button.

Note: To cancel copying, press the stop button.

Copying Options

Select the copying options you want to use for your copies.

Note: Not all options or settings may be available, depending on other copying settings.

Print Settings

Copying option Available settings Description
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Copying option Available settings Description

Printing from a Computer

Before printing from your computer, make sure you have set up your product and installed its

software as described on the Start Here sheet.

Note: If you have an Internet connection, it is a good idea to check for updates to your product

software on Epson's support website. If you see a Software Update screen, select Enable

automatic checking and click OK. The update scans your system to see if you have the latest

product software. Follow the on-screen instructions.

Printing with Windows

You can print with your product using any Windows application, as described in these sections.

Note: If you are using your Epson product with the Windows 10 S operating system, you cannot

use the software described in this section. You also cannot download and install any Epson
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product software from the Epson website for use with Windows 10 S; you must obtain software

only from the Windows Store.

Selecting Basic Print Settings - Windows

Select the basic settings for the document or photo you want to print.

1. Open a photo or document for printing.

2. Select the print command in your application.

Note: You may need to select a print icon on your screen, the Print option in the File menu, or

another command. See your application's help utility for details.

3. If necessary, select your product name as the printer you want to use.

Note: You may also need to select Properties or Preferences to view your print settings.

You see the Main tab of your printer settings window:

4. Select the size of the paper you loaded as the Document Size setting.

Note: You can also select the User-Defined setting to create a custom paper size, but you cannot

use the Borderless setting and the Quality setting will be set to Standard.

5. If you are printing a borderless photo, select Borderless. You can click Settings to access

additional options for borderless printing.

Note: You must select a compatible borderless paper type and size to print without borders. Check

the borderless paper compatibility list for details.

6. Select the orientation of your document. Note: If you are printing an envelope, select

Landscape.
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7. Select the type of paper you loaded as the Paper Type setting.

Note: The setting may not exactly match the name of your paper. Check the paper type settings

list for details.

8. Select the Quality setting that matches the print quality you want to use.

9. Select a Color option:

• To print a color document or photo, select the Color setting.

• To print text and graphics in black or shades of gray, select the Black/Grayscale setting.

10. To print on both sides of the paper, select the 2-Sided Printing setting and select the options

you want.

11. To print multiple pages on one sheet of paper, or print one image on multiple sheets of paper,

select one of the settings in the Multi-Page menu and select the printing options you want.

12. To print multiple copies and arrange their print order, select the Copies options.

13. To preview your job before printing, select Print Preview.

14. To save your print job as a project that can be modified and combined with other print jobs,

select Job Arranger Lite.

15. To reduce noise during printing when you select Plain Paper/Bright White Paper, select On in

the Quiet Mode menu.

Note: Enabling Quiet Mode may reduce printing speed.

Print Quality Options - Windows

You can select any of the available Quality options to fine-tune the quality of your print. Some

settings may be unavailable, depending on the paper type and border setting you have chosen.

Draft

For draft printing on plain paper.

Standard

For everyday text and image printing.

Standard - Vivid

For text and graphics with good quality and print speed.

High

For photos and graphics with high print quality.

More Settings

Opens a window that lets you choose among levels of speed and quality.

Multi-Page Printing Options - Windows
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You can select any of the available options in the Multi-Page menu to set up your multi-page print

job.

2-Up and 4-Up

Prints 2 or 4 pages on one sheet of paper. Click the Page Order button to select page layout and

border options.

2×1 Poster, 2×2 Poster, 3×3 Poster, 4×4 Poster

Prints one image on multiple sheets of paper to create a larger poster. Click the Settings button to

select image layout and guideline options.

Selecting Double-sided Printing Settings - Windows

You can print on both sides of the paper by selecting one of the 2-Sided Printing options on the

Main tab.

Note: Some options may be pre-selected or unavailable, depending on other settings you have

chosen or if you are accessing the product over a network.

1. Select one of the following options for 2-Sided Printing:

• Auto (Long-edge binding) to print your double-sided print job by automatically flipping the paper

on the long edge.

• Auto (Short-edge binding) to print your double-sided print job by automatically flipping the paper

on the short edge.

• Manual (Long-edge binding) to print your double-sided print job by printing one side and

prompting you to flip the paper over on the long edge to print the other side (recommended for

paper types that do not support automatic duplexing).

• Manual (Short-edge binding) to print your double-sided print job by printing one side and

prompting you to flip the paper over on the short edge to print the other side (recommended for

paper types that do not support automatic duplexing).

2. Click the Settings button.

You see this window:
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3. Select the double-sided printing options you want to use.

4. Click OK to return to the Main tab.

5. Click the Print Density button.

You see this window:
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6. Select the type of document you are printing as the Document Type setting. The software

automatically sets the Adjustments options for that document type.

7. If necessary, select the Adjustments options you want to use.

8. Click OK to return to the Main tab.

9. Print a test copy of your double-sided document to test the selected settings.

10. Follow any instructions displayed on the screen during printing.

Double-sided Printing Options - Windows 

You can select any of the available options on the Binding Settings window to set up your double-

sided print job.

Binding Edge Options

Select a setting that orients double-sided print binding in the desired direction.

Binding Margin Options

Select options that define a wider margin to allow for binding.

Start Page

Selects whether printing starts on the front or back page.

Create Folded Booklet Options

Select the Booklet checkbox and a binding option to print double-sided pages as a booklet.

Print Density Adjustments - Windows

You can select any of the available options on the Print Density Adjustment window to adjust the

print quality of your double-sided print job.

Print Density

Sets the level of ink coverage for double-sided printing.

Increase Ink Drying Time

Sets the amount of time required for drying ink after printing on one side of the paper before

printing the other side in double-sided printing to prevent ink smearing.

Selecting Additional Layout and Print Options - Windows 

You can select a variety of additional layout and printing options for your document or photo on the

More Options tab.
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1. To change the size of your printed document or photo, select the Reduce/Enlarge Document

checkbox and select one of these sizing options:

• Select the Fit to Page option to size your image to fit the paper you loaded. Select the size of

your document or photo as the Document Size setting, and the size of your paper as the Output

Paper setting. If you want to center your image on the paper, select the Center option.

• Select the Zoom to option to reduce or enlarge your document or photo by a specific percentage.

Select the percentage in the % menu.

2. Select one of the following Color Correction options:

• Select Automatic to automatically adjust the sharpness, brightness, contrast, and color saturation

for your image.

• Select Custom and click the Advanced button to manually adjust the color correction settings or

turn off color management in your printer software.

• Select Image Options to access additional settings for improving printed images.

Note: You can also select Color Universal Print settings.

3. To add the following features, click the Watermark Features button:

• Anti-Copy Pattern: adds a watermark that only appears when your printout is copied

• Watermark: adds a visible watermark to your printout

• Header/Footer: adds information such as the date and time to the top or bottom of your printout

Note: Click the Settings button to customize the text and location of the header or footer.

4. Select any of the Additional Settings options to customize your print.
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Custom Color Correction Options - Windows 

You can select any of the available options in the Color Correction window to customize the image

colors for your print job.

Color Controls 

Lets you select a Color Mode setting, individual settings for Brightness, Contrast, Saturation, and

Density, and individual color tones. Depending on the selected color mode, you can also adjust the

midtone density using the Gamma setting.

Fix Photo

Improves the color, contrast, and sharpness of flawed photos.

Note: Fix Photo uses a sophisticated face recognition technology to optimize photos that include

faces. For this to work, both eyes and the nose must be visible in the subject's face. If your photo

includes a face with an intentional color cast, such as a statue, you may want to turn off Fix Photo

to retain the special color effects.

ICM

Lets you manage color using installed color printing profiles.

No Color Adjustment

Turns off color management in your printer software so you can manage color using only your

application software.

Image Options and Additional Settings - Windows

You can select any of the Image Options and Additional Settings to customize your print. Some

options may be pre-selected or unavailable, depending on other settings you have chosen.
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Image Options

Emphasize Text

Adjusts the weight of printed text to increase readability.

Emphasize Thin Lines

Adjusts the weight of printed lines to increase visibility.

Edge Smoothing

Smooths jagged edges in low-resolution images such as screen captures or images from the Web.

Fix Red-Eye

Reduces or removes red-eye in photos.

Print Text in Black

Prints colored text in black.

For Color Text

Prints colored text on a background pattern or underlined.

For Color Graphs and Images

Prints colored graphics and images with overlay patterns.

For Color Text, Graphs, and Images

Prints colored text, graphics, and images with overlay patterns.

Enhancement Options

Specifies Color Universal Print enhancement settings for text, graphics, and images.

Additional Settings Options

Rotate 180º

Prints the image rotated 180º from its original orientation.

High Speed

Speeds up printing but may reduce print quality.

Mirror Image

Flips the printed image left to right

Header/Footer Settings - Windows

You can select any of the Header/Footer Settings options to add headers or footers when you

print. The items are available to print at the top or bottom of your pages, in either the left, right, or

center of the page.

Note: These settings are not saved with your document.
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You can select to print the following information:

• User Name

• Computer Name

• Date

• Date/Time

• Document Name

• Collate Number (copy number)

Note: The user name, computer name, date, and time come from the Windows Control Panel on

your computer.

Selecting a Printing Preset - Windows

For quick access to common groups of print settings, you can select a printing preset on the Main

or More Options tab.

Note: You can create your own preset by clicking the Add/Remove Presets button.

1. Click the Main or More Options tab. You see the available Printing Presets on the left:
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2. Place your cursor over one of the Printing Presets to view its list of settings.

3. Click on a preset to change its settings, or use any of the available options on the screen to

control your printing presets.

4. To choose a preset for printing, select it.

5. Click OK.

Selecting Extended Settings - Windows

You can select additional settings that apply to all the print jobs you send to your product.

1. Access the Windows Desktop and right-click the  icon for your product in the right side of

the Windows taskbar, or click the up arrow and right-click .

2. Select Printer Settings.

3. Click the Maintenance tab.

You see the maintenance options:
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4. Click the Extended Settings button.

You see this window:
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5. Select any of the extended settings to customize your print.

6. Click OK to close the Extended Settings window.

7. Click OK to close the printer software window.

Extended Settings - Windows

You can select from these settings on the Extended Settings window.

Enable EPSON Status Monitor 3

Enables product monitoring for ink and paper supplies and other issues.

Separator Page

Before each document, prints a separator page containing the title, user, date, and time.

Remove white borders

Removes white margins that may appear when you print borderless photos.

Always Spool RAW Datatype

Increases print speed and may solve other printing problems.

Page Rendering Mode

Increases print speed when printing is extremely slow or the print head stops during printing.

Print as Bitmap

Increases print speed when printing is extremely slow or the print head stops during printing, and

other settings do not help.

Skip Blank Page

Ensures that your product does not print pages that contain no text or images.

Change Standard Resolution

Reduces the resolution of print data to correct printing problems.

Refine screening pattern

Prints graphics with a finer screening pattern.

Allow Applications to Perform ICM Color Matching

Allows applications to perform ICM color matching.

Always Use the Driver's Paper Source Setting

Prints using the paper source setting in the printer driver, rather than the setting in your application.

Output 1 page documents facedown in 2-Sided mode

Outputs single-sided pages in a 2-sided print job facedown instead of faceup.

Output documents for filing
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Outputs all landscape, portrait, 1-sided, and 2-sided documents in the same orientation for easier

filing.

Barcode mode

Reduces bleeding when printing barcodes on plain paper, letterhead paper, recycled paper,

preprinted paper, envelopes, and thick paper.

Printing Your Document or Photo - Windows

Once you have selected your print settings, you are ready to save your settings and print.

1. Click OK to save your settings.

You see your application's Print window, such as this one:

2. Click OK or Print to start printing.

Locking Printer Settings - Windows

Windows administrators can lock access to some printer settings to prevent unauthorized changes.

1. Do one of the following:

• Windows 10: Click  and select  (Settings) > Devices > Printers & scanners. Select your

product name and select Manage > Printer properties.
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• Windows 8.x: Navigate to the Apps screen and select Control Panel > Hardware and Sound >

Devices and Printers. Right-click your product and select Printer properties.

• Windows 7: Click  and select Devices and Printers. Right-click your product and select

Printer properties.

• Windows Vista: Click and select Control Panel. Click Printer under Hardware and Sound,

then right-click your product and select Properties.

2. Click the Optional Settings tab.

Note: You can prevent access to the Optional Settings tab by changing the user or group

permissions in the Security tab.

3. Click Driver Settings. You see this window:

4. Select the checkbox for each setting you want to lock. To lock all print settings, select All

Document Settings.

5. Under Advanced Settings, select the setting option you want to use for each locked setting.

6. Click OK.

Locked Setting Options

Select the options you want to use for any locked print settings.
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Setting Options Description

Selecting Default Print Settings - Windows 

When you change your print settings in a program, the changes apply only while you are printing in

that program session. If you want to change the print settings you use in all your Windows

programs, you can select new default print settings.

1. Access the Windows Desktop and right-click the  icon for your product in the right side of

the Windows taskbar, or click the up arrow and right-click .

2. Select Printer Settings.

You see the printer settings window:
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3. Select the print settings you want to use as defaults in all your Windows programs.

4. Click OK. These settings are now the defaults selected for printing. You can still change them as

needed for printing in any program session.

Changing the Language of the Printer Software Screens 

You can change the language used on the Windows printer software screens.

1. Access the Windows Desktop and right-click the  icon for your product in the right side of

the Windows taskbar, or click the up arrow and right-click  .

2. Select Printer Settings. You see the printer settings window.

3. Click the Maintenance tab.

You see the maintenance options:
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4. Select the language you want to use as the Language setting.

5. Click OK to close the printer software window. The printer software screens appear in the

language you selected the next time you access them.

Changing Automatic Update Options

Your printer software for Windows automatically checks for updates to the product software. You

can change how often the software checks for updates or disable this feature.

1. Access the Windows Desktop and right-click the  icon for your product in the right side of

the Windows taskbar, or click the up arrow and right-click  .

2. Select Software Update Settings.

You see this window:
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3. Do one of the following:

• To change how often the software checks for updates, select a setting in the Check every menu.

• To disable the automatic update feature, select the Never option.

4. Click OK to exit.

Note: If you choose to disable the automatic update feature, you can check for updates manually.

Printing with the Built-in Epson Driver - Windows 10 S 

You can print with the built-in Epson printer driver using any printing program on Windows 10 S, as

described in these sections.

Note: The built-in Epson driver in Windows 10 S does not include all the available print settings for

your product. To print with additional settings, download and install the Epson Print and Scan utility

from the Windows Store. You cannot download and install any Epson product software from the

Epson website for use with Windows 10 S; you must obtain software only from the Windows Store.

Selecting Print Settings - Windows 10 S

Select the settings for your print job in your Windows 10 S application.

1. Open a photo or document for printing.

2. Select the print command in your application.

Note: You may need to select a print icon on your screen, the Print option in the File menu, or

another command. See your application's help utility for details.

3. If necessary, select your product name as the printer you want to use. Note: You may also need

to select Properties or Preferences to view your print settings.

You see a window like this:
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4. Select the type of paper you loaded as the Media setting.

Note: The setting may not exactly match the name of your paper. Check the paper type settings

list for details.

5. Click the Advanced button.

You see a window like this:

6. Select the size of the paper you loaded as the Paper Size setting.

7. To print multiple copies, select or enter the number as the Copy Count setting.
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8. To print multiple copies of multi-page documents in sets, select the Collated checkbox.

9. Click OK. You return to the printing preferences window.

10. Select the Layout tab.

11. Select the orientation of your document as the Orientation setting.

12. To print double-sided, select one of the Print on Both Sides options, depending on how you

want to orient the page layout. The icon next to each option shows the layout.

13. Click OK to save your settings. You see your application's Print window.

14. Click OK or Print to start printing
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Printing on a Mac 

You can print with your product using any Mac printing program, as described in these sections.

Note: If you have an Internet connection, it is a good idea to check for updates to your product

software on Epson's support website.

Selecting Basic Print Settings - Mac

Select the basic settings for the document or photo you want to print.

1. Open a photo or document for printing.

2. Select the print command in your application.

Note: You may need to select a print icon on your screen, the Print option in the File menu, or

another command. See your application's help utility for details.

3. Select your product as the Printer setting.

4. If necessary, click the arrow next to the Printer setting or the Show Details button to expand the

print window.

You see the expanded printer settings window for your product:
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Note: The print window may look different, depending on the Mac OS version and the application

you are using.

5. Select the Copies and Pages settings as necessary.

Note: If you do not see these settings in the print window, check for them in your application before

printing.

6. Select the page setup options: Paper Size and Orientation.

Note: If you do not see these settings in the print window, check for them in your application before

printing. They may be accessible by selecting Page Setup from the File menu.
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7. Select any application-specific settings that appear on the screen, such as those shown in the

image above for the Preview application.

8. Select Print Settings or Printer Features from the pop-up menu.

You see these settings:

9. Select the type of paper you loaded as the Media Type setting.

Note: The setting may not exactly match the name of your paper. Check the paper type settings

list for details.

10. Select the Print Quality setting you want to use.
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11. Select the Borderless checkbox if you want to print a borderless photo. If the option is grayed

out, change the Media Type setting to a paper type that supports borderless printing.

12. Select any of the available print options

Print Quality Options - Mac

You can select any of the available Print Quality options to fine-tune the quality of your print. Some

settings may be unavailable, depending on the paper type setting you have chosen.

Draft

For draft printing on plain paper.

Normal 

For everyday text and image printing.

Normal - Vivid 

For everyday text and image printing with good quality and print speed.

Quality

For text and graphics with increased quality and print speed.

Best Quality 

For the best print quality, but the slowest print speed.

Print Options - Mac 

You can select any of the print options to customize your print. Some options may be unavailable,

depending on other settings you have chosen.

Expansion 

If you selected a borderless paper size setting, this option adjusts the image expansion settings to

control printing at the edges of borderless prints.

Grayscale 

Prints text and graphics in black or shades of gray.

Mirror Image 

Lets you flip the printed image horizontally.

Note: If you select the Min option for the Expansion setting, you may see white borders on your

printed photo.

Selecting Page Setup Settings - Mac 

Depending on your application, you may be able to select the paper size and orientation settings

from the print window.
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Note: If you do not see these settings in the print window, check for them in your application before

printing. They may be accessible by selecting Page Setup from the File menu.

1. Select the size of the paper you loaded as the Paper Size setting. If you are printing a

borderless photo, select the Borderless checkbox or a paper size with a Borderless option. You

can also select a custom setting to create a custom paper size, but the Quality setting will be

limited to Normal.

Note: You must select a compatible borderless paper type and size to print without borders. Check

the borderless paper compatibility list for details.

2. Select the orientation of your document or photo as shown in the print window.

Note: If you are printing an envelope, select the icon.

Note: You can reduce or enlarge the size of the printed image by selecting Paper Handling from

the pop-up menu and selecting a scaling option.

Managing Color - Mac

You can adjust the Color Matching and Color Options settings to fine-tune the colors in your

printout, or turn off color management in your printer software.

1. Select Color Matching from the pop-up menu in the print window.

2. Select one of the available options.

3. Select Color Options from the pop-up menu in the print window.
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Note: The available settings on the Color Options menu depend on the option you selected on the

Color Matching menu.

4. Select one of the available options.

Color Matching and Color Options - Mac

You can select from these settings on the Color Matching and Color Options menus.

Color Matching Settings

EPSON Color Controls

Lets you manage color using controls in your printer software or turn off color management.

ColorSync

Prints using standard color profiles for your product and paper to help match image colors. You can

customize the conversion method and filter settings on the ColorSync pop-up menu in the print

window.

Color Options Settings

Manual Settings

Lets you select manual color adjustments. Click the arrow next to Advanced Settings and select

settings for Brightness, Contrast, Saturation, and individual color tones. You can also select a color

Mode setting for printing photos and graphics and the Fix Red-Eye setting to reduce or remove

redeye in photos. Depending on the selected color mode, you can also adjust the midtone density

using the Gamma setting.

Fix Photo
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Improves the color, contrast, and sharpness of flawed photos. Click the arrow next to Advanced

Settings and select the Fix Red-Eye setting to reduce or remove red-eye in photos.

Note: Fix Photo uses a sophisticated face recognition technology to optimize photos that include

faces. For this to work, both eyes and the nose must be visible in the subject's face. If your photo

includes a face with an intentional color cast, such as a statue, you may want to turn off Fix Photo

to retain the special color effects.

Off (No Color Adjustment)

Turns off color management in your printer software so you can manage color using only your

application software.

Note: An ICC profile is required if color management is turned off.

Printing Your Document or Photo - Mac 

Once you have selected your print settings, you are ready to print.

Click Print at the bottom of the print window.
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Checking Print Status - Mac 

During printing, you can view the progress of your print job, control printing, and check ink status.

1. Click the printer icon when it appears in the Dock. You see the print status window:
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2. Select the following options as necessary for your Mac OS version:

• To cancel printing, click the print job and click  or Delete.

• To pause a print job, click the print job and click or Hold. To resume a print job, click the

paused print job and click or Resume.

• To pause printing for all queued print jobs, click Pause or Pause Printer.

• To display other printer information, click Settings or Supply Levels.

Scanning

Starting a Scan Using the Product Control Panel 

You can scan an image to your computer using your product's control panel buttons. Your product

automatically selects default scan settings, but you can view or change them as necessary. When

scanning to a memory card, you can change the scan settings using the product's LCD screen. If

you are scanning to a computer, you can change the default scan settings using the Event

Manager utility on the computer.

1. Make sure you installed the product software and connected the product to your computer or

network.
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Note: Restart your computer after installing the product software to enable scanning from the

control panel. Also make sure the Event Manager program is not being blocked by your firewall or

security software.

2. Press the home button, if necessary.

3. Press the left or right arrow button to select Scan and press the OK button.

You see a screen like this:

4. Press the left or right arrow button to select a scan option and press the OK button.

• To Memory saves your scan file on a memory card and lets you select the file format, quality, and

other settings.

• To Computer (JPEG) saves your scan as a JPEG file on your computer or as an image capture

on a Mac.

• To Computer (PDF) saves your scan as a PDF file on your computer or as an image capture on a

Mac.

• To Computer (Email) scans your original and attaches it to a message in your e-mail program.

You can select the e-mail program you want to use and resize your image, if necessary, from an

option screen on your computer.

Note: This works with MAPI-type email such as Microsoft Outlook, Windows Live Mail, Mac Mail,

and Entourage, but not web-based email such as Gmail.

• To Computer (WSD) lets you manage network scanning in Windows 10, Windows 8.x, Windows

7, or Windows Vista (English only). To use this feature, you must first set up a WSD (Web Services

for Devices) port on your Windows 7 or Windows Vista computer (the port is set up automatically

on Windows 10 and Windows 8.x).

5. Do one of the following:
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• If you are scanning to a network computer, select the target computer from the list. If your product

is connected directly to your computer with a USB cable, select USB Connection.

• If you are scanning to a memory card, review the scan settings. To change them, press the down

arrow button.

6. Press the start button to start scanning.

Scan to Memory Card Options 

Select the scanning options you want to use when scanning to a memory card.

Setting Available options Description

Changing Default Scan Job Settings 

You can view or change the default scan job settings your product uses when you scan to your

computer. You do this using the Event Manager program.

1. Do one of the following to open Event Manager:

• Windows 10: Click and select EPSON Software > Event Manager.

• Windows 8.x: Navigate to the Apps screen and select Event Manager.

• Windows (other versions): Click  or Start > All Programs or Programs > EPSON Software >

Event Manager.

• Mac: Open the Applications folder, click Epson Software, and select Event Manager.

2. Open the Scanner (Windows) or Select Scanner (Mac) drop-down list and select your product, if

necessary.
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3. Click Make Job Settings.

4. Open the Edit Job Settings drop-down list and select the scan job settings you want to view or

change.

5. Change the settings as necessary.

6. Click OK.

7. Click Close to close the Event Manager window.

Starting a Scan Using the Epson Scan 2 Icon

You can start the Epson Scan 2 program to select scan settings, scan, and save the scanned

image to a file.

Note: If you are using your Epson product with the Windows 10 S operating system, you cannot

use the software described in this section. You also cannot download and install any Epson

product software from the Epson website for use with Windows 10 S; you must obtain software

only from the Windows Store.

• Windows 10: Click  and select EPSON > Epson Scan 2.

• Windows 8.x: Navigate to the Apps screen and select Epson Scan 2.

• Windows (other versions): Click or Start, and select All Programs or Programs. Select

EPSON > Epson Scan 2 > Epson Scan 2.

• Mac: Open the Applications folder, open the Epson Software folder, and select Epson Scan 2.

You see an Epson Scan 2 window like this:
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Starting a Scan from a Scanning Program 

You can start Epson Scan 2 from a TWAIN-compliant scanning program to select scan settings,

scan, and open the scanned image in the program.

Note: If you are using your Epson product with the Windows 10 S operating system, you cannot

use the software described in this section. You also cannot download and install any Epson

product software from the Epson website for use with Windows 10 S; you must obtain software

only from the Windows Store.

1. Open your scanning program and select its scanning option. (See your scanning program help

for instructions.)
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2. Select your product. Note: In certain programs, you may need to select your product as the

"source" first. If you see a Select Source option, choose it and select your product. With Windows,

do not select a WIA option for your product; not all scan functions will be available.

You see an Epson Scan 2 window like this:

Starting a Scan from a Smart Device

You can start a scan from a smart device using the Epson iPrint app. You can save the scanned

document to your device or a cloud service, e-mail it, or print it.

Note: If you are using your Epson product with the Windows 10 S operating system, you cannot

use the software described in this section. You also cannot download and install any Epson
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product software from the Epson website for use with Windows 10 S; you must obtain software

only from the Windows Store.

Note: Your device must be connected to the same wireless network as your Epson product.

1. Download the Epson iPrint app from your device's app store or from Epson's website.

2. Place your original on the product for scanning.

3. Open the Epson iPrint app and select your product.

4. Select the scan settings and scan your original.

5. Save your scanned image to a file or cloud location.

Scanning in Epson Scan 2

Epson Scan 2 automatically scans your document and saves the scanned file in PDF format in

your operating system's Documents or My Documents folder, or opens it in your scanning

program. You can select settings, preview, and change the scanned file settings as necessary.

Note: If you are using your Epson product with the Windows 10 S operating system, you cannot

use the software described in this section. You also cannot download and install any Epson

product software from the Epson website for use with Windows 10 S; you must obtain software

only from the Windows Store.

1. Start Epson Scan 2

You see this window:
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2. Select the Document Source setting that matches where you placed your original.

3. Select the Document Size setting that matches the size of your original. You can select

Customize to enter a custom size, if necessary.

4. Select the image type of your original and how you want it scanned as the Image Type setting.

5. Select the Resolution setting you want to use for your scan.

6. Click the Preview button. Epson Scan 2 previews your original and displays the results in the

Epson Scan 2 window.
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7. Select any of the additional settings that you want to use on the Main Settings tab.

8. Click the Advanced Settings tab and select any settings that you want to use.

9. Select the format in which you want to save your scanned file as the Image Format setting. If

necessary, select Options and select any desired format options.

10. Enter the file name for your scanned file in the File Name field. If necessary, select Settings to

modify the file name settings.

11. Select the location in which you want to save your scanned file as the Folder setting. If

necessary, select Select to create a new folder.

12. Click Scan. The product scans your original and saves the scanned file in the location you

specified.

Refilling Ink

Check Ink Levels

Checking Ink Levels on Your Product 

To confirm the actual ink levels, visually check the ink levels in the product’s ink tanks. Make sure

the ink levels are above the lower lines on the ink tanks.
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Note: The product has a low ink alert system. The accuracy of this system depends on the user

refilling the ink tanks correctly. The product cannot directly measure the ink levels in the tanks;

instead it estimates the amount of ink remaining by internally monitoring ink usage. The low ink

alert system may generate inaccurate messages if the ink tanks are not refilled according to these

instructions. As a precaution, perform regular visual inspections of the ink tanks to ensure ink

levels do not fall below the lower line. Continued use of the product when the ink level is below the

lower line on the tank could damage the product.

Checking Ink Levels - Windows

A low ink reminder appears if you try to print when ink is low, and you can check your ink levels at

any time using a utility on your Windows computer.

1. To check your ink levels, access the Windows Desktop and double-click the icon for your

product in the right side of the Windows taskbar, or click the up arrow and double-click  .

You see a window like this:
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2. Refill any ink tank as needed.

Note: The ink levels displayed are an estimate and may differ from the actual ink remaining in the

ink tanks. To confirm the actual remaining ink, visually check the ink levels in the ink tanks.

Continued use of the product when the ink level is below the lower line on the tank could damage

the product.

Checking Ink Levels - Mac 

You can check your ink levels using a utility on your Mac.

1. In the Apple menu or the Dock, select System Preferences. Select Print & Fax, Print & Scan, or

Printers & Scanners, select your product, and select Options & Supplies. Select Utility and select

Open Printer Utility.

2. Select EPSON Status Monitor.

You see a window like this:
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3. Refill any ink tank as needed.

Note: To update or refresh the displayed ink levels, click Update.

Note: The ink levels displayed are an estimate and may differ from the actual ink remaining in the

ink tanks. To confirm the actual remaining ink, visually check the ink levels in the ink tanks.

Continued use of the product when the ink level is below the lower line on the tank could damage

the product.

Disabling Special Offers with Windows 

You can disable special offers messages from Epson using a utility on your Windows computer.

1. Access the Windows Desktop and right-click the icon for your product in the right side of

the Windows taskbar, or click the up arrow and right-click  . Select Monitoring Preferences.

You see this window:
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2. To disable promotional offers, deselect the Display Epson Offers checkbox.

Refilling the Ink Tanks

Make sure you have new ink bottles handy and have read the ink safety precautions before you

begin. You can continue to use the product even if one or more ink tanks are not filled all the way.

However, for the most accurate ink level monitoring, fill all the ink tanks up to the top line.

Note: The product has a low ink alert system. The accuracy of this system depends on the user

refilling the ink tanks correctly. The product cannot directly measure the ink levels in the tanks;

instead it estimates the amount of ink remaining by internally monitoring ink usage. The low ink

alert system may generate inaccurate messages if the ink tanks are not refilled according to these

instructions. As a precaution, perform regular visual inspections of the ink tanks to ensure ink

levels do not fall below the lower line. Continued use of the product when the ink level is below the

lower line on the tank could damage the product.

Caution: Wear disposable gloves while refilling the ink tanks to avoid staining your hands. If ink

spills, wipe it off immediately with a damp towel to avoid permanent stains. If ink gets on your

clothes or belongings, it may not come off.
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1. Turn on your product.

2. Lift up the scanner unit.

3. Open the ink tank cover, then open the cap for the ink tank you are going to fill

4. Hold the ink bottle upright and slowly turn the bottle cap to remove it.
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Caution: Do not shake or squeeze the bottle. Do not touch the top of the bottle after its cap is

removed.

Warning: If ink gets on your skin, wash it thoroughly with soap and water. If ink gets into your

eyes, flush them immediately with water. If ink gets into your mouth, spit it out immediately. Seek

medical advice if problems persist. Keep the ink bottles out of the reach of children and do not

drink the ink.

5. Position the top of the ink bottle along the slot in front of the filling port, then slowly stand the

bottle up to insert it.

Note: Refer to the color-coded sticker on the ink tank unit to identify the color of each tank. Do not

force the bottles into position; they are keyed for each color.

6. Wait for the ink to fill the tank. Do not squeeze the bottle. Ink flows into the tank and stops

automatically when the ink is filled to the upper line.
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Note: If ink does not flow from the bottle, lift and reinsert the bottle.

7. When the ink tank is full, remove the ink bottle and securely close the ink tank cap.

Note: If any ink remains in the bottle, replace the bottle cap and tighten it. Store the bottle upright

for later use.

8. Repeat the previous steps as necessary for each ink tank you need to refill.

9. Close the ink tank cover, then close the scanner unit
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10. Press the home button to display the home screen, then select Maintenance > Reset Ink

Levels. Follow the on-screen instructions to reset the ink level for the colors you refilled.

Cleaning and Transporting Your Product

Cleaning Your Product

To keep your product working at its best, you should clean it several times a year. Close the output

tray and front cover when you are not using the product to protect it from dust.

Caution: Do not use a hard brush, alcohol, or paint thinner to clean the product or you may

damage it. Do not use oil or other lubricants inside the product or let water get inside it.

1. Turn off the product.

2. Unplug the power cable.

3. Disconnect any connected cables.

4. Remove all the paper.

5. Clean the scanner glass with a soft, lint-free cloth (microfiber is recommended), moistened with

a little glass cleaner.

Caution: Do not spray glass cleaner directly on the glass and do not press the glass surface with

any force.

6. Clean the outer case and control panel with a soft, dry cloth. Do not use liquid or chemical

cleansers.

Transporting Your Product

If you need to store your product or transport it some distance, prepare it for transportation as

described here. 171

Caution: During transportation and storage, follow these guidelines:

• Avoid tilting the product, placing it vertically, or turning it upside down; otherwise ink may leak
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• When storing or transporting an ink bottle after removing its seal, do not tilt the bottle and do not

subject it to impacts or temperature changes. Otherwise, ink may leak even if the cap on the ink

bottle is tightened securely. Be sure to keep the ink bottle upright when tightening the cap, and

take measures to prevent ink from leaking when transporting the ink bottles.

• Do not put opened ink bottles in the box with the product.

• Do not carry the product by its control panel; this may damage the product.

Note: Before storing your product for a long period, replace low, expended, or expired ink to help

prevent the print head from drying out. Store your product in a cool, dry place.

1. Turn off the product.

2. Lift up the scanner unit and check to see if the print head is in the far right position (the home

position). If not, turn on the product, wait for the print head to move to the far right, then turn the

product off again.

3. Secure the print head to the case with tape.
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Caution: Do not place tape on the white flat cable or transparent film inside the product; otherwise,

you may damage your product.

4. Lower the scanner unit.

5. Remove all the paper from the product.

6. Unplug the power cable.

7. Disconnect any connected cables.

8. Open the ink tank unit cover and make sure that the ink tank caps are installed securely
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9. Close the ink tank cover and scanner unit.

10. Close the paper support, feeder guard, and output tray. Then lower the control panel by

squeezing the release bar and gently pushing the panel down

Caution: Do not lower the control panel without first squeezing the release bar or you may

damage your product.
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11. Place the product in its original packaging materials, if possible, or use equivalent cushioning

around the product. Be sure to remove the tape from the print head before turning on your product.

If print quality has declined when you print again, clean and align the print head.

Solving Problems 

Check these sections for solutions to problems you may have using your product.

Product Status Messages

You can often diagnose problems with your product by checking the messages on its LCD screen.

(E-01) A printer error has occurred. Turn the product off and then back on again. If the error

continues, check for a paper jam. If there is no paper jam, contact Epson for support.

(E-02) A scanner error has occurred. Turn the product off and then back on again.

(E-11) The ink pad needs to be replaced. Contact Epson for support.

(W-01) Paper is jammed in the product. Remove the jammed paper, then press the button

indicated on the LCD screen to clear the error. If the error continues, turn the product off and back

on again.

(W-11) An ink pad is nearing the end of its service life. Contact Epson for support. (To continue

printing, press the start button.)

(I-22) To establish a wireless connection using an access point, press the button on the access

point or click the button on the access point's wireless settings screen displayed on your computer

screen.

(I-23) Enter the PIN code displayed on the LCD screen into the access point or computer within

two minutes. If you wait longer than two minutes, a time-out error occurs, the code changes, and

you must enter a new code.

(I-31) To make wireless connection settings from your computer, run the installer and follow the on-

screen instructions.

(I-41) The Paper Setup Auto Display option is disabled. You must enable Paper Setup Auto Display

to use AirPrint.

(I-60) Your computer may not support WSD (Web Services for Devices). The Scan to PC (WSD)

function is available only for computers running English versions of Windows 10, Windows 8.x,

Windows 7, or Windows Vista.

Recovery Mode A firmware update has failed. Connect your product using a USB cable and try

updating the firmware again. If you still receive this error message, contact Epson for support.

Note: The ink pads in the printer collect, distribute, and contain the ink that is not used on printed

pages. During the life of your product it may reach a condition where either satisfactory print quality
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cannot be maintained or the ink pads have reached the end of their usable life. The Epson Status

Monitor, your LCD screen, or lights on the control panel will advise you when these parts need

replacing. If this happens during the standard warranty of the product, the exchange of the product

or replacement of the pads is covered under the standard warranty. If the product is out of

warranty, the pads can be replaced by any Epson authorized service provider. The waste ink pads

are not a user-replaceable part.

Message Appears Prompting

You to Reset Ink Levels If you see a message on the LCD screen prompting you to reset the ink

levels, do the following:

1. Refill all of the ink tanks or the ink tanks indicated on the LCD screen all the way to the top.

Note: Depending on the operating conditions, you may see the ink reset message even when

there is still ink in the tanks.

2. Select the colors that you refilled on the LCD screen.

3. Follow the instructions on the LCD screen to reset the ink levels.

Note: The product has a low ink alert system. The accuracy of this system depends on the user

refilling the ink tanks correctly. The product cannot directly measure the ink levels in the tanks;

instead it estimates the amount of ink remaining by internally monitoring ink usage. The low ink

alert system may generate inaccurate messages if the ink tanks are not refilled according to these

instructions.

As a precaution, perform regular visual inspections of the ink tanks to ensure ink levels do not fall

below the lower line. Continued use of the product when the ink level is below the lower line on the

tank could damage the product.

Running a Product Check

Running a product check helps you determine if your product is operating properly.

1. Disconnect any interface cables connected to your product.

2. Load plain paper in the product.

3. Press the home button, if necessary.

4. Select Maintenance and press the OK button.
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5. Select Nozzle Check and press the OK button.

6. Press the start button. The nozzle check pattern is printed.

7. Do one of the following, depending on the results of the product check:

• If the page prints and the nozzle check pattern is complete, the product is operating properly. Any

operation problem you may have could be caused by your computer, cable, software, or selected

179 settings. Check the other solutions in this book or try uninstalling and reinstalling your printer

software.

• If the page prints but the nozzle check pattern has gaps, clean or align the print head.

• If the page does not print, the product may have a problem. Check the other solutions in this

manual. If they do not work, contact Epson.

Resetting Control Panel Defaults

If you have a problem with settings on the product control panel, you can reset them to their factory

defaults. You can choose which settings to reset or reset them all.
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1. Press the home button, if necessary.

2. Press the arrow buttons to select Settings and press the OK button.

3. Select Restore Default Settings and press the OK button.

4. Select one of these options:

• Network Settings: Resets all network settings.

• All except Network: Resets all settings except network settings.

• All Settings: Resets all settings. You see a confirmation screen.

5. Press the OK button to reset the selected settings. (Press the stop button if you want to cancel

the operation.)

Solving Setup Problems

Noise After Filling the Ink

If you hear noises from your product after filling the ink tanks with ink, check these explanations:

• The first time you fill the tanks with ink, the product must charge its print head. Wait until charging

finishes before you turn off the product, or it may charge improperly and use excess ink the next

time you turn it on. Your product is finished charging the print head when the power light stops

flashing.

• If the product's print head stops moving or making noise, and the charging process has not

finished after approximately 20 minutes, turn off your product. Turn it back on and check to see if

charging is still in progress. If it is still in progress, contact Epson for help.

Control Panel Setup Problems

If you have problems setting up the control panel, try these solutions:

• To view LCD screen text in a different language, select a different language setting for the panel.
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• To adjust the position of the control panel, carefully raise or lower it.

Solving Network Problems

Check these solutions if you have problems setting up or using your product on a network.

Note: Breakdown or repair of this product may cause loss of network data and settings. Epson is

not responsible for backing up or recovering data and settings during or after the warranty period.

We recommend that you make your own backup or print out your network data and settings.

Product Cannot Connect to a Wireless Router or Access Point

If your product has trouble finding or connecting to a wireless router or access point, try these

solutions:

• If you are connecting the product via Wi-Fi Protected Setup (WPS) and the Wi-Fi icon on your

product's LCD screen is not lit or does not appear, make sure you select one of the WPS options

from the product control panel within 2 minutes of pressing the WPS button on your router.

• Make sure to place your product within contact range of your 2.4 GHz router or access point.

Avoid placing your product near a microwave oven, 2.4 GHz cordless phone, or large metal object,

such as a filing cabinet.

Note: If you are using a 5 GHz wireless router, set the router to operate in dual band (2.4 GHz and

5 GHz) mode. If your router uses a single network name (SSID) for both the 2.4 GHz and 5 GHz

band, give each band its own network name (SSID) instead, such as Home Network 2.4 GHz and

Home Network 5 GHz. See your router documentation or contact your internet service provider for

instructions.

• Verify that your router or access point is operating correctly by connecting to it from your

computer or another device.

• Print a network connection report and check the codes and messages on the report to help

determine the cause of the problem.

• You may need to disable the firewall and any anti-virus software on your wireless router or

access point.

• Try restarting your router following the instructions in your router documentation.

Note: If you are reading these instructions online, you will lose your Internet connection when you

restart your router.

• Check to see if access restrictions, such as MAC address filtering, are set on the router or access

point. If access restrictions are set, add your product's MAC address to your router's address list.

To obtain your product's MAC address, print a network status sheet. Then follow the instructions in

your router or access point documentation to add the address to the list.

• If your router or access point does not broadcast its network name (SSID), follow the instructions

that came with your product to enter your wireless network name manually.
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• If your router or access point has security enabled, determine the kind of security it is using and

any required password or passphrase for connection. Then make sure to enter the exact WEP key

or WPA passphrase correctly.

• Check if your computer is restricting the available wireless channels. If so, verify that your

wireless access point is using one of the usable channels and change to a usable channel, if

necessary.

• If you are using a Wi-Fi Direct connection that suddenly disconnects, the Wi-Fi direct password

on your device may have been changed. If necessary, delete the existing DIRECT-xxxxxxxx

connection settings from your device and enter a new password. See your device documentation

for instructions.

• If you connected your product to a Windows computer using Wi-Fi Direct and it automatically

selected Access Point Mode, you may have trouble accessing a low-priority Internet connection.

Check the network connection or adapter settings in the Windows Control Panel and set the

Internet metric setting to 100 for your version of the Internet Protocol.

Network Software Cannot Find Product on a Network

If EpsonNet Setup cannot find your product on a network, try these solutions:

• Make sure your product is turned on and connected to your network. Verify the connection using

your product control panel.

• Check if your network name (SSID) contains non-ASCII characters. Your product cannot display

nonASCII characters.

• Print a network connection report and check the codes and messages on the report to help

determine the cause of the problem.

• Make sure your product is not connected to a guest network.

• If necessary, reinstall your product software and try running EpsonNet Setup again:

1. Reset your product's network settings to their factory defaults.

2. Windows only: Uninstall your product software.

3. Restart your router following the instructions in your router documentation.

Note: If you are reading these instructions online, you will lose your Internet connection when you

restart your router, so note the next step before restarting it.

4. Download your product software from the Epson website using the instructions on the Start Here

sheet.

• If you have replaced your router, reinstall your product software to connect to the new router.

Note: If you are using a 5 GHz wireless router, set the router to operate in dual band (2.4 GHz and

5 GHz) mode. If your router uses a single network name (SSID) for both the 2.4 GHz and 5 GHz

band, give each band its own network name (SSID) instead, such as Home Network 2.4 GHz and
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Home Network 5 GHz. See your router documentation or contact your internet service provider for

instructions.

• Check to see if your wireless router or access point has an enabled Privacy Separator function

that is preventing detection of your device over the network. See your router or access point

documentation for instructions on disabling the Privacy Separator function.

Wireless Network Connection is Unstable on a Mac

If you connected a device to a USB 3.0 port on your Mac, you may experience wireless network

interference between your product and your Mac.

If you cannot connect to your product over the wireless network or the connection becomes

unstable, move the device connected to your Mac USB 3.0 port further away from your Mac.

Cannot Print Over a Network 

If you cannot print over a network, try these solutions:

• Make sure that your product is turned on.

• Make sure you install your product's network software as described in your product

documentation.

• Print a network status sheet and verify that the network settings are correct. If the network status

is Disconnected, check any cable connections and turn your product off and then on again.

• Print a network connection report and check the codes and messages on the report to help

determine the cause of the problem.

• If you are using TCP/IP, make sure the product's IP address is set correctly for your network. If

your network does not assign IP addresses using DHCP, set the IP address manually.

• Make sure your computer and product are both using the same wireless network.

• If network printing is slow, print a network status sheet and check the signal strength. If it is poor,

place your product closer to your router or access point. Avoid placing your product near a

microwave oven, 2.4 GHz cordless phone, or large metal object, such as a filing cabinet. 

Note: If you are using a 5 GHz wireless router, set the router to operate in dual band (2.4 GHz and

5 GHz) mode. If your router uses a single network name (SSID) for both the 2.4 GHz and 5 GHz

band, give each band its own network name (SSID) instead, such as Home Network 2.4 GHz and

Home Network 5 GHz. See your router documentation or contact your internet service provider for

instructions.

• Try restarting your router following the instructions in your router documentation.

Note: If you are reading these instructions online, you will lose your Internet connection when you

restart your router.
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• Check to see if your wireless router or access point has an enabled Privacy Separator function

that is preventing printing from a device over the network. See your router or access point

documentation for instructions on disabling the Privacy Separator function.

• If you are connecting the product wirelessly via EpsonNet Setup and the Wi-Fi connection icon is

not lit or does not appear on the product's LCD screen, make sure your product software was

installed correctly. If necessary, reinstall your software.

Solving Paper Problems

Check these sections if you have problems using paper with your product.

Paper Feeding Problems

If you have problems feeding paper, try these solutions:

• Place the product on a flat surface.

• If paper does not feed for printing, remove it. Then reload it in the middle of the rear paper feed.

Slide the edge guide against the edge of the paper, making sure that the paper stack is not above

the arrow mark on the edge guide.

• If multiple pages feed at once, remove the paper, fan the edges to separate the sheets, and

reload it.

• If paper jams when you load only one or two sheets, try loading more sheets at a time. Do not

load more than the recommended number of sheets.

• If paper jams when you print on both sides of the paper, try loading fewer sheets.

• Make sure your paper meets the specifications for your product.

• Make sure the paper size and paper type settings on the control panel are correct.

• Try cleaning the paper path.

• For best results, follow these guidelines:

• Use new, smooth, high-quality paper that is not curled, creased, old, too thin, or too thick.

• Load paper in the rear paper feed printable side up.

• Follow any special loading instructions that came with the paper.

Paper Jam Problems Inside the Product 

If you see a message that paper has jammed inside the product, follow the steps here.

1. Cancel the print job, if necessary.

2. Remove any jammed paper from the rear paper feed
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3. Lift the scanner unit and remove any jammed paper inside.
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Caution: Do not touch the flat white cable or translucent film inside the printer. 

4. Close the scanner unit.
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5. Follow the prompts on the LCD screen to clear any error messages. If you still see a paper jam

message, check the other paper jam solutions.

Paper Jam Problems in the Rear Cover

If you see a message that paper has jammed in the rear cover, follow the steps here.

1. Cancel the print job, if necessary.

2. Pull any jammed paper out of the rear paper feed.

3. Press the buttons to release the rear cover and remove the cover from your product. Carefully

remove any jammed paper from inside the product.
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4. Press in the buttons and reattach the rear cover.

Warning

This content is compiled from multiple sources and is provided for reference purposes only. It may not be

complete or fully applicable to all situations. If you are unable to resolve your issue, please contact the

product manufacturer or an authorized service provider for official support. 
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